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IMPORTANT NOTE  
 

The ST365 software application should already be installed on 
your computer before you connect a Spectrum Techniques 
hardware device to it and power on the device.  If you have already 
connected an ST device, do not power it on until after the software 
installation has completed.  
 
If you encounter difficulties during the installation process that 
prevent the software from successfully installing, it may be 
because you are attempting the install the software again after it 
has already been installed.  Check Control Panel > Programs and 
Features on your computer to see whether there is already an entry 
named STUST365Setup that appears in the list.  If you find that this 
entry appears in the list, then you must first uninstall 
STUST365Setup before you attempt to follow the steps in this user 
manual. 
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INTRODUCTION 
The purpose of this guide is to provide you with assistance to quickly install, set up, and begin 

using the ST365 desktop software application with your Spectrum Techniques hardware device.  

The application allows the user to save data to the PC and to use the features described in the 

Using Your System section found later in this document.  The latest software version of the 

ST365 software is available on our website at 

spectrumtechniques.com/products/instruments/st365. 

http://spectrumtechniques.com/
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INSTALL SOFTWARE 
You are not required to be logged in as a local administrator in order to install the software.  

However, if you are not a local administrator on your computer, then during the installation 

process the installer will ask for a local administrator password in order for it to continue.  We 

recommend that you either know this administrator password yourself or have available to you 

the assistance of someone who knows this password.  The software will not install properly 

without this password. 

Make sure the computer operating system of the PC you want to install the ST365 software 

application on is at Windows 7 or higher.  The application will not run properly on versions older 

than Windows 7.  The software operates equally well on 32-bit and 64-bit computers. 

The following discussion assumes that you have already downloaded the STUST365Setup.exe 

file.  If you have not, then you may obtain this file from our public website.  To do this open a 

web browser and navigate to http://spectrumtechniques.com/products/instruments/ST365.  

From here click the Downloads tab.  This takes you to a Downloads webpage.  Scroll down and 

find a line that looks like this: 

Download   PC – STU ST365 Software 

Click on the Download text to download STUST365Setup.exe.  The will cause the 

STUST365Setup.exe file to download to your computer.  Once downloading is complete drag 

the file to a convenient location on your computer Desktop.  The new file looks like this: 

 

Double-click this file.  Doing this starts the process of installing the Spectrum Techniques Ultra 

ST365 application software on your computer.  You will see a new window appear that looks 

like Figure 2: 

http://spectrumtechniques.com/products/instruments/ST365
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Figure 2 

Click Next.  The window changes to look something like Figure 3: 
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Figure 3 

Click Install.  The window changes to look something like Figure 4: 

 

Figure 4 

Next, the window changes to look like Figure 5: 
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Figure 5 

Click Finish.  A new window appears that looks like Figure 6: 

 

Figure 6 
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Click Next.  After a moment the window changes to look like Figure 7: 

 

Figure 7 

Click Finish.  The window changes to look like Figure 8: 

 

Figure 8 
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A new window appears that looks like Figure 9: 

 

Figure 9 

Click Install.  After a moment this window disappears and you see a window that looks like 
Figure 10: 

 

Figure 10 

Click Finish.  At this point Spectrum Techniques Ultra and accompanying device driver should 
be properly installed on your computer.  On your Desktop you should see that a new shortcut 
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icon has been installed.  The shortcut is named ST365.  On your computer Desktop find a new 
shortcut icon that looks like this: 

 

You may use the ST365 shortcut to launch the ST365 desktop software application.  If for any 

reason the software application quits responding to user input, you can use a shortcut named 

ST365EndProcess to terminate the application.  ST365EndProcess is accessible from the Start 

Menu by navigating to All Programs > Spectrum Techniques > ST365EndProcess.   

ST365EndProcess is intended for use to force a non-responsive session of the 

SpectrumTechniquesUltra application to close.  This is useful in the event that it gets stuck and 

refuses to respond to user commands.  After you have resolved the communication problem  

use the ST365 icon to relaunch to ST365 software application and reconnect. 

EXPLORE ST365 SUB-FOLDERS 
This section discusses the internal folder structure used by the ST365 application. You may skip 

this section if you want to immediately proceed to system setup.   

Open a session of Windows Explorer.  Navigate to the folder C:\ProgramData\Spectrum 

Techniques LLC\SpectrumTechniquesUltraST365\AppConfig_Files.  Do not modify or delete the 

contents of any of the files in this folder.  This folder is where the ST365 software stores many 

of the text files that it uses to control how the ST365 software application behaves during normal 

operation.   

There is a subfolder named Backup located within the AppConfig_Files folder.  This backup 

folder contains archived copies of the SpectrumTechniquesUltraST365.config file located in 

AppConfig_Files.  If for some reason while using the ST365 software application it becomes 

unstable or will not run, you can try replacing the SpectrumTechniquesUltraST365.config file 

located in folder AppConfig_Files with a recent config file from the Backup folder.  Make sure 

the ST365 app is not running at the time you do this.  Also, be sure to rename the backup file to 

say SpectrumTechniquesUltraST365.config after you copy it to the AppConfig_Files folder.  

Doing this will restore the configuration to a recent one that is known to work correctly.  This 

should fix the problem with not being able to run the ST365 software and get it back to working 

again.   

Navigate to the folder C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\DeviceParams_Files.  Do not modify or delete any of the 

files in this folder.  This folder is where the ST365 software application stores device parameters 

for each of the various Spectrum Techniques hardware devices that the ST365 application has 

had connected to it.  When the software was initially installed the only file contained in this folder 

was named Default.stx.  This file is used as a template for the initial configuration of a new 

device the first time that device gets USB or LAN-connected to the computer that runs the 

ST365 software application.  Do not modify or delete this Default.stx file.  After you connect the 

ST365 application to a new device and subsequently disconnect from the device, a new .stx file 

gets automatically created and will appear in the DeviceParams_Files folder.  This new .stx file 
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name consists of the custom model and the serial number of the device that was connected.  

Normally, there is no reason to modify or delete any of the custom files located within folder 

DeviceParams_Files.  Deleting a custom file from this folder will cause the ST365 software to 

recreate the custom file from the Default.stx file the next time you connect to that particular 

device. 

 

SYSTEM SETUP 
Use the following instructions only after you have completed the software installation procedure 

described above in the INSTALL SOFTWARE section of this document.  Connect your detector 

probe to the hardware device you plan to use.  Depending on which particular device you use, 

you should connect it to the computer by following the procedure outlined in the appropriate 

Spectrum Techniques setup manual.  Spectrum Techniques supplies setup manuals for models 

ST160, ST260, ST360, ST365, and ST475. 

Run the ST365 software application.  One way of doing this is by double-clicking the ST365 icon 

located on the computer Desktop.  It looks like this: 

 

After a brief initialization delay the main application window appears on screen.  This window 

should look similar to Figure 11. 
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Figure 11 

 

Note in Figure 11 that the status bar contains a red text block that says No Device Selected.  

When you see this red text block in the status bar, it is telling you that the ST365 software 

application is not presently controlling a Spectrum Techniques hardware device.  At runtime the 

ST365 application will attempt to determine how many Spectrum Techniques devices are turned 

on and are USB-connected to the computer.  If there is only one device turned on and USB-

connected, then the ST365 application will automatically attempt to connect to it.  If there is 

more than one device connected or the application does not automatically connect, you should 

click the ST MODELS button within the Quick Commands toolbar.  This button allows you to 

manually connect to a Spectrum Techniques device.   

Clicking the ST MODELS button causes the application to pop up a Select Spectrum 

Techniques Device window as shown in Figure 12. 
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Figure 12 

 

This window offers three different ways to connect to a device.  The first way is by using the 

dropdown menu located next to the label Select Local USB Device.  Note that by default this 

dropdown box says No Device Selected.  Click the down arrow to see more connection options.  

Each option shown is for a particular Spectrum Techniques device that is currently turned on 

and USB-connected to the local computer.  If for some reason this dropdown box does not 

contain the model and serial number of a USB-connected device that you want to use, click the 

Refresh Local USB List button.  This causes the contents of the dropdown box to refresh.  Click 

the Select Local USB Device dropdown box again and see whether it now contains the device 

you want to use.  If it does, then select the device and click Connect.  If the dropdown box does 

not contain the device, then try turning the USB-connected device off, wait a few seconds, and 

turn the device back on.  Then click the Refresh Local USB List button again and see whether 

the device name now appears and is selectable within the Select Spectrum Techniques Device 

dropdown box.  If all else fails, click the Cancel button to dismiss the window.  Then click the ST 

MODELS button again to try again to connect. 

With the device now turned on and USB-connected, again click the Select Local USB Device 

dropdown box.  This time it should display a list of all USB-connected devices. See Figure 13.  

The example shown here is for the case where there is only one Spectrum Techniques device 

available from which to choose.  The device is named st365 4998, COM8.  This means that the 

device is a Spectrum Techniques model ST365 using serial number 4998 and that it is 

connected to the host computer using COM port 8.  Click the Connect button.   
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Figure 13 

A second way to connect is by using the dropdown menu located next to the label Select LAN 

Device IP address.  The software uses this method of connecting only if the Select Local USB 

Device menu says No Device Selected.  By default the Select LAN Device IP address dropdown 

box says No IP Address Selected.  Click the down arrow to see more connection options.  Each 

option shown is an IP address of a particular Spectrum Techniques device that is turned on and 

is LAN-connected to your computer’s local network.  If for some reason this dropdown box does 

not contain the IP address of a LAN-connected device that you want to use, click the Refresh 

LAN IP Address List button.  This causes the application to update its list of LAN-connected 

devices and to refresh the dropdown list.  This process might take a few seconds to complete.  

Once the list has completed updating click the dropdown menu once again and select the 

desired IP address for the device you want to use.  Click the Connect button. 

A third way to connect is by using the text box located next to the label Enter a known LAN 

Device IP Address.  The software uses this method of connection only if the Select Local USB 

Device menu says No Device Selected and the Select LAN Device IP address menu says No IP 

Address Selected.  This text box is useful in the case where you already know the IP address of 

the LAN-connected Spectrum Techniques device you want to use.  Simply type the IP address 

into the box and click the Connect button. 

When you click the Connect button the Select Spectrum Techniques Device window disappears 

and, after a moment, the Spectrum Techniques Ultra main window updates to look something 

like Figure 14. 
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Figure 14 

Note that the status bar now has a green text block that says something like st365 sn4998, 

COM8. When you see this green text block in the status bar, it tells you that the ST365 software 

application is currently in control of a Spectrum Techniques device and what its connection 

information is.  Note that the information displayed here pertains to USB-controlled devices.  

When the ST365 software application is in control of a LAN-controlled device the green text 

block will display something similar to this: 

st365 sn4998, 10.1.10.128, 70-B3-D5-95-30-02 

The text displayed here tells you the model number, serial number, IP address, and MAC 

address of the Spectrum Techniques device currently under control of the ST365 software 

application.  The MAC address shown corresponds to the MAC address included on a label 

affixed to the underneath side of each Spectrum Techniques device.  This MAC address is 

unique for all devices manufactured by Spectrum Techniques.  By comparing the MAC address 

displayed on-screen with the MAC addresses of your Spectrum Techniques devices you can 

determine which physical device the ST365 software application is currently controlling.   
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The gray text block to the right of this green block shows the firmware version information for 

the Display, High Voltage, LAN, and WiFi software component within the device. For each 

software component the version notation is MajorRevision#.MinorRevision#.Build#.  If you do 

not see this gray text block try enlarging the width of the main application window until the gray 

text block appears. If you encounter problems operating your ST365 device and contact 

Spectrum Techniques for technical support, the technician assigned to help you might ask you 

to provide them with this information.  To the right of the firmware text block is the Channel Gain 

Multiplier and, when the main application window is set wide enough to display it, the Probe 

Type.  At this point your ST365 software is connected to a device and is ready to use. 

USING YOUR SYSTEM 
The ST365 main window is comprised of several sub-windows.  See Figure 15 below for the 

names of each of these sub-windows. 

Figure 15 
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Toolbar Shortcut Buttons 
The toolbar located near the top of the main ST365 application window contains shortcut 

buttons useful for accessing various application tools.  Here is a brief description of what each 

of these buttons is used for. 

 

  The Data Graph button is used to display the Data Graph window.  The user may click 

this button anytime the Data Graph window is not visible on screen and they want to display it.  

See the discussion below regarding the Data Graph window itself for details on how to use it. 

  The Configure Device button is used to display the Configure Device window.  The user 

may click this button anytime the Configure Device window is not visible on screen and they 

want to display it.  See the discussion below regarding the Configure Device window itself for 

details on how to use it. 

 

  The Common Commands button is used to display the Common Commands window.  

The user may click this button anytime the Common Commands window is not visible on screen 

and they want to display it.  See the discussion below regarding the Common Commands 

window itself for details on how to use it. 

 

  The Edit Parameters button is used to display the Edit Parameters window.  The user 

may click this button anytime the Edit Parameters window is not visible on screen and they want 

to display it.  See the discussion below regarding the Edit Parameters window itself for details 

on how to use it. 

 

  The Quick Commands button is used to display the Quick Commands window.  The user 

may click this button anytime the Quick Commands window is not visible on screen and they 

want to display it.  See the discussion below regarding the Quick Commands window itself for 

details on how to use it. 

 

  The Control Outputs button is used to display the Control Outputs window.  The user 

may click this button anytime the Control Outputs window is not visible on screen and they want 

to display it.  See the discussion below regarding the Control Outputs window itself for details on 

how to use it. 
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  The Start Counts button is used to begin running an experiment using a given set of four 

run parameters.  The four parameters used are Number of Runs, Preset Time, Pause Time 

Between Runs, and High Voltage.  These parameters are accessible via the Quick Parameters 

Control Window and should be assigned by the user prior to clicking the Start Counts button.  

Note that the Start Counts button is not used to start either a plateau experiment or a half-life 

experiment.  Those experiments have their own mechanism for starting an experiment and do 

not depend on the Start Counts button in order to start. 

When an experiment starts, the status bar will display two additional items of information.  

These items are the Elapsed Time and ETA.  The Elapsed Time item shows how much time 

has elapsed since the current experiment started.  For example, if you see Elapsed Time: 

01:23:45 on the status bar, this means that the experiment has been running for 1 hour, 23 

minutes, and 45 seconds.  The ETA item shows the estimated time that the currently running 

experiment will finish.  For example, if you see ETA: 02:34:56 PM on the status bar, this means 

that the estimated time that the experiment will finish is 2:34:56 PM.  Note that these two items 

will remain visible on the status bar even after the experiment has finished. 

 

  The Pause Counts button is used to pause a currently running experiment.  When the 

user clicks the Pause Counts button the current run of the experiment ends and the ST365 

application pauses.  The application remains paused until the user clicks either the Start Counts 

button to resume running of the experiment or clicks Stop Counts to terminate the experiment.  

If the user clicks the Start Counts button, then the application resumes at the next run of the 

experiment. 

 

  The Stop Counts button is used to terminate a currently running experiment.  When the 

user clicks the Stop Counts button the current experiment aborts and the ST365 application 

enters a state where it is ready to start another experiment. 

 

  The Clear Configuration Parameters button is used to clear the data items contained in 

the Information Window, the Run Results Window, the Data Graph Window, and the Control 

Outputs Window.  Use this button when you want to set the User Interface back to how it looked 

when the ST365 software application first connected to the Spectrum Techniques device.  

Clicking the Clear Configuration Parameters button does not clear the contents of the Quick 

Parameters Control Window or the Experiment Results Window. 

 

  The Shutdown Application button is used to shut down the ST365 software application.  

The application pops up a window asking you to confirm that you want to shut down.  If an 
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experiment is running at time of shut down, the experiment aborts and all ST365 windows close.  

Note that when the application shuts down, it automatically saves the current location and size 

of the main application window along with the location of the Configure Device window.  It also 

saves all current parameters settings of the device that were in effect at the time the application 

shut down. 

 

Windows Contained within the Main Application Window 
The main ST365 application contains five sub-windows.  These sub-windows are: 

 Information Window 

 Quick Commands Window 

 Control Outputs Window 

 Run Results Window 

 Quick Parameters Control Window 
 

 

Information Window 
The Information Window displays requests for user input or real-time information about an 

experiment that is in progress.  During an experiment this window displays number of counts, 

count rate, elapsed time, high voltage, or alarm point.  Depending on how the count rate is 

configured, the Information Window displays either counts per second or counts per minute.  

Also, count rate may be configured to show the rate in either a digital or an analog format. 

 

Quick Commands Window 
The Quick Commands Window displays a list of menu buttons.  When the status bar displays 

the red text block No Device Selected, the Quick Commands Window will contain only one 

menu button, ST MODELS.  In order to connect to a Spectrum Techniques device the user 

should click this ST MODELS button.  Doing so causes the Select Spectrum Techniques Device 

window to display. 

Whenever the ST365 application is connected to a hardware device, the status bar displays a 

green text block with the device name in it.  As long as a hardware device is connected, the 

Quick Commands Window displays four additional menu buttons.  These are CONFIGURE 

DEVICE, STU SETUP, PLATEAU EXPERIMENT, and HALF LIFE EXPERIMENT.  Click 

CONFIGURE DEVICE to display the Configure Device window.  Click STU SETUP to display 

the STX Setup Experiment window.  Click PLATEAU EXPERIMENT to display the STX Plateau 

Experiment window.  Click HALF LIFE EXPERIMENT to display the STX Half-Life Experiment 

window.  See below for details on how to use each of these four windows. 
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Control Outputs Window 
The Control Outputs Window displays information about the connected device.  If an 

experiment is currently underway, then the window displays real-time information about the 

experiment. 

 

Run Results Window 
The Run Results Window displays a table of run results.  Each row in the table contains run 

details for the given experiment run.  The columns headers in the table tell what information is 

contained in each cell of the table.  Depending on how the user initiates each experiment, the 

Run Results Table might contain several groups of experiment results.  The results are listed 

top-to-bottom in the table in reverse chronological order.  The first column in the table (Total : 

Current Run #) shows how each group is separated from other groups in the table. 

The user may change which columns are displayed in the Run Results Table.  The user does 

this by displaying the Configure Device window and then clicking on or off one or more of the 

checkboxes in the Columns shown in Runs Results group.  If a box in the group is unchecked, 

then the corresponding column will be excluded from the Run Results Table the next time an 

experiment is run.  If a box in the group is checked, then the corresponding column will be 

included in the Run Results Table the next time an experiment is run.  If the Run Results Table 

already contains rows of run results at the time the user makes changes to column headers in 

the table, then the contents of the table automatically clears the next time an experiment runs.  

The ST365 application does this in order to prevent any inconsistency in data cell contents 

between old and new column header layouts. 

 

Quick Parameters Control Window 
The Quick Parameters Control Window displays an editable list of four of the most important 

setup parameters.  These parameters are Number of Runs, Preset Time, Pause Time Between 

Runs, and High Voltage.  There are two ways to edit the parameter values contained within 

each row of the window.  The user may use the up and down arrow buttons on a particular row 

to edit the given parameter.  An up arrow click increments the parameter and a down arrow click 

decrements the parameter.  Alternatively, the user may edit the parameter directly by mouse-

clicking inside the appropriate parameter edit box and using the computer keyboard to edit the 

parameter.  Press the ‘Enter’ key when you are done.   

If you modify a parameter while an experiment is already underway, the ST365 software will not 

update the parameter until after the current experiment has completed.  Note that the plateau 

experiment and the half-life experiment commands have their own parameter settings.  These 

two experiments use their own set of parameters instead of using the ones shown in the Quick 

Parameters Control Window when either of these two experiments run. 
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Menu Bar 
The ST365 software application contains a menu bar located along the top of the main 

application window.  Once the ST365 application is connected to a Spectrum Techniques 

device the menu bar updates to look like Figure 16. 

 

 

Figure 16 

 

The menu bar contains a set of ten dropdown menus.  The following discussion explains the 

purpose of each dropdown menu and their submenus.  

 

File 

 

The File menu allows the user to perform file IO operations.  Click the Load Run Results File… 

menu item to open a previously saved Run Results file into the Run Results Table.  The run 

results contained in the file is stored in a Tab-Separated-Values format.  A Run Results Table 

file contains a snapshot of the device information in use by the ST365 application at the time the 

file was saved.  This information includes configuration settings and run result contents for the 

connected Spectrum Techniques device.  Configuration settings include experiment description, 

firmware version, probe type, course gain, upper voltage threshold, lower voltage threshold, 

elapsed time, number of runs, preset time, pause time, alarm level, high voltage, step voltage, 

and audio volume.  Run results contents include all of the rows in the Run Results table that 

existed at the time that the file was saved. 
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Click the Save Run Results Table As… menu item to save Configuration Settings and Run 

Results Table contents to a file.  The ST365 application asks the user to enter a file name.  The 

information contained in the file includes configuration settings and run results contents for the 

connected Spectrum Techniques device.  Configuration settings include experiment description, 

firmware version, probe type, course gain, upper voltage threshold, lower voltage threshold, 

elapsed time, number of runs, preset time, pause time, alarm level, high voltage, step voltage, 

and audio volume.  Run results contents include the current rows shown in the Run Results 

Table. 

Click the Open DataGraph Folder menu item to open a new Windows Explorer window.  The 

files shown in this window are located at C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\DataGraph_Files.  The DataGraph is discussed later in 

this document.  It allows the user to save a .grph file.  A .grph file contain all of the graph 

information that existed within the DataGraph at the time the file was saved.  The ST365 

application allows you to load a previously saved DataGraph file back into the Data Graph 

window by using the command Data Graph > Comparison Graphs > Load Graph From File… 

Click the Open DeviceParams Folder menu item to open a new Windows Explorer window.  The 

files shown in this window are located at C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\DeviceParams_Files.  The files contained here are .stx 

files.  There is one .stx file for each Spectrum Techniques device that the ST365 application has 

controlled.  Each .stx file contains setup information for a given device.  This information 

includes high voltage, preset time, number of runs, etc.  The ST365 application uses these .stx 

files to save setup information of a device and to restore this setup information the next time the 

device is controlled by the ST365 application.   

Click the Open Log Folder menu item to open a new Windows Explorer window.  The files 

shown in this window are located at C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\Log_Files.  The files contained here are .txt files.  

Each .txt file contains detailed logging information for the current session of the ST365 

application.  Note that you must turn logging on in order for the ST365 application to create the 

Log files.  You do this from within the Edit Parameters window by turning ON Config Mode > 

Write Debug Info To Log File.  In order to enable logging you must turn ON Write Debug Info To 

Log File every time you connect to a Spectrum Techniques device.  As long as logging is turned 

on the top line in the Information Window will display the word ‘Logging’.  This is so you can tell 

at a glance whether the ST365 application is currently performing logging. 

Click the Open RunResultsTable Folder menu item to open a new Windows Explorer window.  

The files shown in the windows are located at C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\RunResult_Files.  The files contained here are .txt files.  

Each .txt file contains configuration settings and run results table contents for the given 

Spectrum Techniques device.  There are two ways to create a RunResults files; either from the 

File > Save Run Results Table As… dropdown menu or by clicking the Save Run Results button 

located at the bottom of the Run Results Table window.  Note that the ST365 application waits 

until the current run is completed before it saves the current Run Results.  This is necessary so 

as to assure that the save operation does not interfere with the currently executing run.  The 

ST365 application allows you to load a previously saved Run Results file back into the Run 

Results Table by using the Load Run Results File… command. 
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Click the Open SavedEditParameters Folder menu item to open a new Windows Explorer 

window.  The files shown in this window are located at C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\SavedEditParameters_Files.  The files contained here 

are .txt files.  Each .txt file contains a complete listing of all parameters that were exported using 

the Edit Parameters > Export All command.  The Edit Parameters window is discussed later in 

this document.  It contains Setup, OnOff, and Delay parameters that customize the operation of 

the ST365 application.  Should you experience problems with normal operation of your ST365 

application and require technical support from Spectrum Techniques, a Spectrum Techniques 

technician may request that you perform an Export All command and send the resulting file to 

Spectrum Techniques for analysis. 

Click the Print Data Graph… menu item to select a printer to use and to send the current data 

graph contents to that printer.  If your computer already has a PDF printer driver installed, then 

you may use it to print to PDF file rather than to a physical printer.  That way you can initially 

save the data graph to a file and later print it onto paper if you want to do so. 

Click the Print Data Graph Preview menu item to display a printable preview window of the Data 

Graph window.  The title of the preview window displays the label names used for the X and Y 

axes, the model and serial number of the Spectrum Techniques device, and the date and time 

when the preview window was generated.  At their option, the user may print the contents of the 

preview window.  The user may also zoom in on various portions of the preview window to see 

more details of the data graph. 

Click the Print Setup menu item to specify layout details of the printed data graph.  Details 

include paper size, page orientation (portrait or landscape), and paper margins. 

Click the Exit menu item to terminate the ST365 application. 

 

Edit 

 

The Edit menu allows the user to perform Run Results operations.  Click the Copy Run Results 

to Clipboard menu item to copy the current Configuration Settings and Run Results to the 

operating system Clipboard.  The user may then paste the information into an application such 

as Microsoft Notepad or Wordpad. 

Click the Clear Run Results menu item to clear the contents of the Run Results Table. 

Click the Pause Collecting Run Results menu item to disable automatic saving of run results to 

the Run Results Table after each run of an experiment.  Note that clicking this menu item 

causes the menu text to change to say Resume Collecting Run Results.  This means that 

clicking the menu item again will re-enable automatic saving of run results to the Run Results 

Table after each run of an experiment. 
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Setup 

 

The Setup menu allows the user to specify four setup parameters to use in experiments.  These 

are experiment description, high voltage, step voltage, and audio volume.  Step voltage is used 

during a plateau experiment to determine how the voltage will increase from one run to the next.  

Audio volume setpoint parameter is used by certain Spectrum Techniques devices such as the 

ST360.  Whenever the count rate is at or above the audio volume setpoint the device emits an 

audible tone. 

Click the Continuous Save menu item to toggle continuous save ON or OFF.  When continuous 

save is toggled ON a checkbox appears next to the Continuous Save menu item.  Continuous 

Save applies to a running experiment.  If continuous save is ON, then after each experiment run 

completes the ST365 application automatically saves the contents of the Run Results table to a 

file.  If continuous save is OFF, then no file gets automatically saved during the experiment. 

Click the Reset Serial Port Connection menu item to close the currently open connection to the 

Spectrum Techniques device.  The Quick Commands window updates to display only the ST 

MODELS button.  Click the ST MODELS button to attempt to reconnect to the Spectrum 

Techniques device. 

Click the ReSync menu item to attempt to open a new device.  It first tries a USB connection, 

then a serial port connection. 

 

View 
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The View menu allows the user to specify ST365 application display settings.  Click the Digital 

Rate Meter menu item to display a separate window that contains a digital version of the current 

count rate.  During an experiment run the count rate shown in the window constantly updates to 

show the current count rate. 

Click the Analog Rate Meter menu item to display a separate window that contains an analog 

version of the current count rate.  During an experiment run the count rate shown in the window 

constantly updates to show the current count rate. 

Click the CPS menu item to cause the ST365 application to use units of counts-per-second 

when displaying the count rate.  Note that a checkbox appears next to the CPS menu item 

indicating that this is the current units for count rate display. 

Click the CPM menu item to cause the ST365 application to use units of counts-per-minute 

when displaying the count rate.  Note that a checkbox appears next to the CPM menu item 

indicating that this is the current units for count rate display. 

Click the Scalar Counts menu item to cause the Information Window to switch to display 

Number of Counts.   

Click the Digital Count Rate menu item to cause the Information Window to switch to Count 

Rate using a digital display. 

Click the Analog Count Rate menu item to cause the Information Window to switch to Count 

Rate using an analog display. 

 

Preset 

 

The Preset menu allows the user to specify five preset parameters used by the ST365 

application.  These are Number of Runs, Preset Time, Pause Time Between Runs, High 

Voltage, and Alarm Point.  Click the Number of Runs menu item to specify the number of runs 

used when the user clicks the Start Counts toolbar button.  Click the Preset Time menu item to 

specify the preset time used when the user clicks the Start Counts toolbar button.  Click the 

Pause Time menu item to specify the pause time used when the user clicks the Start Counts 

toolbar button.  Click the High Voltage menu item to specify the high voltage used when the 

user clicks the Start Counts toolbar button.  Click the Alarm Point menu item to specify the 

alarm point used when the user clicks the Start Counts toolbar button. 
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Device Display 

 

The Device Display menu allows the user to switch to the selected display option within the 

Information Window.  Note that a checkbox appears next to the selected menu item indicating 

which of the five display options is currently in use by the ST365 application. 

Experiments 

 

The Experiments menu allow the user to select a particular experiment that they want to begin.  

Click the Plateau menu item to bring up a dialog box for specifying parameter information 

associated with running a plateau experiment.  Click the Half Life menu item to bring up a dialog 

box for specifying parameter information associated with running a half-life experiment. 

 

Preferences 

 

The Preferences menu allows the user to specify how the ST365 application behaves when the 

application first starts up and when the user starts counts.  Click the Save Run Results Table 

Data on Start Counts menu item to toggle this preference ON or OFF.  A checkbox appears 

next to the Save Run Results Table Data on Start Counts menu item when this preference is 

enabled.  This means that if there are any rows already displayed in the Run Results table prior 

to starting an experiment, the ST365 application will prompt the user to save the information 

contained in the rows prior to starting the experiment. 

Click the Auto Show Data Graph on Start Counts menu item to toggle this preference ON or 

OFF.  A checkbox appears next to the Auto Show Data Graph on Start Counts menu item when 

this preference is enabled.  This indicates that any time a start counts occurs, the data graph 

window will automatically display and plot any graph data that is enabled. 

Click the Load Preferences on Start Up menu item to toggle this preference ON or OFF.  A 

checkbox appears next to the Load Preferences on Start Up menu item when this preference is 

enabled.  This indicates that the ST365 application will automatically load the STX file 



27                                                                   Spectrum Techniques Ultra Rev. 1 

associated with a given Spectrum Techniques device when the application connects to the 

device.  If this preference is disabled, then the ST365 application simply uses whichever 

parameter settings were already in place when the user connected to the Spectrum Techniques 

device. 

 

Window 

 

The Window menu allows to the user to select one of seven ST365 control windows.  These 

control windows are Data Graph, Configure Device, Common Commands, Edit Parameters, 

Quick Commands, Control Outputs, and Experiment History.  A typical reason for selecting one 

of these menu items is because the window is not currently visible and the user wants to display 

it. 

 

Help 

 

The Help menu provides information about how to get help with the ST365 application software.  

Click the Help Files menu item to pop up a help window that details how to obtain this user 

manual.  Click the About menu item to pop up an About Box for the ST365 application software. 

 

Detailed Description of the Control Windows 
Information Window 
The Information Window displays requests for user input or real-time information about an 

experiment that is in progress.  If the ST365 application is not connected to a Spectrum 

Techniques device, the Information Window displays this message: 

No device connected.  Click ST MODELS within Quick Commands to select device type.  Once 

the device is selected you may configure it from the main menu ‘View > Configure Device’. 

This message informs the user that no Spectrum Techniques device is currently enabled within 

the application.  To connect to a device the user should click within the Quick Commands 
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window the ST MODELS button.  Clicking the ST MODELS button displays a window that 

allows the user to select from a list of connected Spectrum Techniques devices.  See Figure 17. 

 

Figure 17 

In this example there is a single Spectrum Techniques device from which to select.  This device 

is named st365 4998, COM8. This indicates that the device is model ST365, the serial number 

is 4998, and the device is connected on COM8.  For this example the user selects the st365 

4998, COM8 menu option and clicks Connect.  Doing so enables the st365 4998 hardware 

device within the ST365 application.  The Information Window updates as shown in Figure 18 to 

display this message: 

Number of Counts: 0 

 

Figure 18 

The information that gets displayed in the Information Window changes based on the viewing 

mode for the window.  For example, if the user clicks the View menu and then clicks Analog 

Count Rate, the Information Window updates to display something like Figure 19. 



29                                                                   Spectrum Techniques Ultra Rev. 1 

Figure 19 

As long as the analog count rate window is displayed and an experiment is running, the gauge 

meter shown will automatically update to show the current count rate.  Note that while Figure 19 

shows the count rate in counts per second (CPS), the user can change the analog count rate 

window to show the count rate in counts per minute (CPM). 

 

Common Commands Window 
The Common Commands Window displays commonly used menu buttons. 

The ST MODELS menu button is intended to be used with the Spectrum Techniques STX line 

of hardware devices.  These devices include models ST160, ST260, ST360, ST365, and ST475.  

Prior to clicking the ST MODELS menu button the user should have already plugged in to the 

computer least one STX model device.  Any hardware device that the user intends to use with 

the ST365 application must already be turned on prior to clicking the ST MODELS menu button.  

See the discussion in SYSTEM SETUP starting on page 11 for more details. 
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Configure Device 
The user clicks the CONFIGURE DEVICE menu button to display the Configure Device window.  

Alternatively, the user may click the toolbar shortcut button to display the Configure Device 

window.  This window is shown in Figure 20. 

 

Figure 20 

Information shown in this window is organized into several groups.  In the upper-left corner of 

the window is the Columns shown in Run Results group.  The seven checkboxes included in 

this group correspond to the columns shown in the Run Results table of the ST365 application.  

Only those boxes that are checked will appear as columns in the table; those boxes that are not 

checked will not appear in the table.  Toggling a checkbox in this group while an experiment is 

in progress has no effect on the contents of the Run Results table for that experiment.  Only 

those boxes that are checked at the time that the experiment starts have any effect on the 

columns shown in the Run Results table. 

Below the Columns shown in Run Results group is the Device Display group.  The five radio 

buttons included in this group correspond to the five display modes available within the 

Information Window.  By default Counts is selected within the Device Display group.  Click on 

any other radio button in the group to select that mode within the Information Window.  The 

selected mode will remain in effect until the user selects an alternate mode. 

The middle section of the Configure Device window contains five of the most important setup 

parameters.  These parameters are Number of Runs, Preset Time, Pause Time, High Voltage, 

and High Voltage Max Allowed.  Each parameter contains an Up button, a Down button, and a 

textbox.  There are two ways for the user to edit the parameter values contained within each 

textbox.  The user may use the up and down arrow buttons on a given row to edit the given 
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parameter.  An up arrow click increments the parameter and a down arrow click decrements the 

parameter.  Alternatively, the user may edit the parameter directly by mouse-clicking inside the 

appropriate parameter edit box and using the computer keyboard to edit the parameter.  Press 

the ‘Enter’ key when you are done.  If you modify a parameter while an experiment is already 

underway, the ST365 software does not update the parameter until after the current experiment 

has finished.  The plateau experiment and the half-life experiment commands have their own 

parameter settings.  These two experiments use their own set of parameters rather than the 

Quick Parameters Control Window parameters when their experiment runs. 

In the lower middle section is the Counter Source group.  The two radio buttons included in the 

group correspond to the two probe-type modes available within the ST365 device.  These 

modes are Geiger-Mueller and Scintillator.  Click the appropriate radio button to toggle between 

these two modes.  When you toggle between modes the connected ST365 device immediately 

switches from one probe-type to the other.  This includes switching to the lower threshold, fine 

gain, and course gain that will be used when conducting experiments. 

Along the upper-right corner of the Configure Device window is a set of nine buttons.  The first 

button is labeled Clear Config Parameters.  Clicking this button causes the ST365 application 

to zero the Number of Runs, Preset Time, Pause Time Between Runs, High Voltage, Current 

Run Number, Runs Remaining, and Elapsed Time.  While the Clear Config Parameters button 

is handy for zeroing all parameters, note that it is rare that the user should need do this.  Also, 

there is no mechanism for undoing this operation. 

 

 

 

 

 

 

 

 

Setup Experiment 
The next button is labeled ST365 Setup.  Clicking this button causes the ST365 application to 

display the STX Setup Experiment window.  See Figure 21. 
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Figure 21 

Use the STX Setup Experiment window to set up various parameters associated with running 

an experiment.  Note that the Audio Level selection applies only to the ST360 and earlier 

model Spectrum Techniques devices.  The ST365 and later models do not incorporate the 

audio level feature.  The Continuous Save checkbox controls whether the ST365 application will 

automatically write to disk the run details for the total number of runs completed after each run 

comprising an experiment.  Click ReSync to cause the ST365 application to attempt to 

reestablish connection to the Spectrum Techniques hardware device.  Click OK to accept the 

new parameters that you entered; click Cancel to ignore the new parameters. 

 

Plateau Experiment 
The next button is labeled Plateau Experiment.  Clicking this button causes the ST365 

application to display the STX Plateau Experiment window.  See Figure 22. 

 

Figure 22 

Use the STX Plateau Experiment window to set up various parameters associated with running 

a plateau experiment.  The Start and End high voltage range parameters define the range of 

voltages used for the runs of the plateau experiment.  The Step Voltage parameter defines the 

amount that the voltage increments for each run of the plateau experiment.  For example, if the 
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start voltage is 800, the end voltage is 1000, and the step voltage is 25, then when the plateau 

experiment executes, it will consist of runs occurring at 800 volts, 825 volts, 850 volts, 875 volts, 

900 volts, 925 volts, 950 volts, 975 volts, and 1000 volts.  The Preset Time Per Step parameter 

defines the length of time (in seconds) that each run of the plateau experiment lasts.  The 

Continuous Save checkbox controls whether the ST365 application will automatically write to 

disk the run details for the total number of runs completed after each run comprising an 

experiment.  The Auto Show Data Graph on Start Counts checkbox controls whether the ST365 

application displays the data graph window when the plateau experiment starts.  After each run 

of the plateau experiment the data graph window updates to include the enabled data for the 

given run.  Click Run to accept the new parameters that you entered and to cause the plateau 

experiment to start.  Depending on the starting voltage specified in the STX Plateau Experiment 

window it may take a few seconds before the ST365 application starts the plateau experiment.  

This delay is caused by the time needed for the ST365 application to adjust the device to the 

setpoint high voltage.  Click Cancel to ignore the new parameters and cancel the plateau 

experiment. 

 

Half-Life Experiment 
The next button is labeled Half Life Experiment.  Clicking this button causes the ST365 

application to display the STX Half Life Experiment window.  See Figure 23. 

 

Figure 23 

Use the STX Half Life Experiment window to set up various parameters associated with running 

a half-life experiment.  The user may specify the Number of Runs, the Preset Time Per Run, 

and the High Voltage to use during the half-life experiment.  The Continuous Save checkbox 

controls whether the ST365 application will automatically write to disk the run details for the total 

number of runs completed after each run comprising an experiment.  The Auto Show Data 

Graph on Start Counts checkbox controls whether the ST365 application displays the data 

graph window when the half-life experiment starts.  After each run of the half-life experiment the 

data graph window updates to include the enabled data for the given run.  Click Run to accept 

the new parameters that you entered and to cause the half-life experiment to start.  Depending 

on the voltage specified in the STX Half Life Experiment window it may take a few seconds 

before the ST365 application starts the half-life experiment.  This delay is caused by the time 

needed for the ST365 application to adjust the device to the setpoint high voltage.  Click Cancel 

to ignore the new parameters and cancel the half-life experiment. 
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Data Graph 
The next button is labeled Data Graph.  Clicking this button causes the ST365 application to 

display the Data Graph window.  See Figure 24. 

 

Figure 24 

The Data Graph window displays a graph of output data sets collected during the most recent 

experiment.  Collectively, each data set is referred to as a track. Tracks correspond to each 

enabled data item in the experiment.  Each track is color-coded as indicated by the Graph List 

panel in the data graph.  The color of each track is user-configurable and each track can have 

its own separate color.  This coloring scheme allows the user to easily tell one track from 

another in the Data Graph.  Each point in a given track corresponds to a single run in the 

experiment.  Depending on how the Data Graph is configured, up to seven tracks may be 

displayed simultaneously within the Data Graph.  The user can resize the Data Graph thereby 

allowing it to be as small or as big as necessary. 

Along the top of the Data Graph window is a toolbar menu comprised of three menu buttons.  

Click the Data Graph button to display the following dropdown menu.  See Figure 25. 
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 Figure 25 

The menu items included under the Data Graph dropdown are used to specify a comparison, to 

save a graph to a disk file, to set up the printed page format, to send the currently displayed 

graph to the printer, to assign the text label associated with the y-axis, to toggle the X-Axis 

between displaying the entire range of track data and a fitted range, to toggle between showing 

only the ‘Number of Counts’ track and showing multiple tracks, to enable smoothing of the Y-

Axis ‘Number of Counts’ data, to display the Graph Properties window, and to close the Data 

Graph window.  Click the Adjust X-Axis Range to fit data menu item to turn this feature ON or 

OFF.  When it is ON the menu list will display a checkbox to the left of the menu item.  When it 

is OFF the menu list will not display a checkbox to the left of the menu item.  Click the Show 

‘Number of Counts’ Track Only menu item to turn this feature ON or OFF.  When it is ON the 

menu list will display a checkbox to the left of the menu item.  When it is OFF the menu list will 

not display a checkbox to the left of the menu item. 

Click the Linear menu item to toggle the data graph to display data using linear X and Y axes.  

Click the Semi-Log menu item to toggle the data graph to display graphed data using linear X 

and logarithmic Y axes.  This mode is known as semi-logarithmic and is useful when there are 

multiple tracks included in the data graph that are widely spaced apart in the Y-axis direction.  

By setting the display to Semi-Log the data graph makes it easier to see multiple tracks at the 

same time. 

RMB-click within the data graph window to display the data graph pop-up menu.  See Figure 26. 

Figure 26 

The user can use this pop-up menu to add notes to a data graph.  These notes are useful as 

annotations that the user adds to the data graph in order to clarify or explain special features 
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contained in the graph.  For example, the user might add notes to a plateau experiment data 

graph in order to point out details associated with the flat portion of the Counts track in the 

experiment.  Subsequently, if the user sends the data graph to a printer, the notes that they 

added are included in the printout.  Notes can displayed or hidden from the data graph 

depending on whether the Display Notes box is checked in the pop-up menu. 

Data Graph Properties 
Click the Properties item in the pop-up menu to display the Graph Properties window.  See 

Figure 27. 

 

Figure 27 

The Graph Properties window displays configuration settings that control how the Data Graph 

window operates.  The Y-Axis Range group contains configuration parameters for the data 

graph y-axis.  Use the Max box to specify the upper range of the y-axis.  Use the Min box to 

specify the lower range of the y-axis.  To assign new values to either of these boxes you can 

mouse-click inside one of the boxes and use the keyboard to edit the value.  Alternatively you 

can use the virtual numeric key pad to edit the value.  This numeric key pad is located at the far 

left of the Graph Properties window.  Use this numeric key pad when you need to enter values 

for Max or Min y-axis settings without using the keyboard to do so.   
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Located to the right of the Min and Max boxes are two radio buttons, Semi-Log Range and 

Linear Range.  Use these buttons to toggle the y-axis between the semi-logarithmic and linear 

modes. 

Below the Y-Axis Range group is the Data Graph Color and Visibility group.  The checkboxes in 

this group are used to determine which tracks will appear in the Data Graph window when an 

experiment starts.  To have a track appear in the data graph make sure its corresponding 

checkbox is checked prior to clicking the OK button; to have a track not appear in the data 

graph make sure its corresponding checkbox is not checked prior to clicking the OK button.   

Click the Semi-Log Range radio button.  This causes the Graph Properties window to change to 

look similar to Figure 28. 

 

Figure 28 

The Y-Axis Range group contains configuration parameters for the data graph y-axis.  Use the 

Max box to specify the upper exponent range of the y-axis.  Use the Min box to specify the 

lower exponent range of the y-axis.  To assign new values to either of these boxes you can 

mouse-click inside one of the boxes and use the Up/Down arrows to edit the value.  

Alternatively you can use the virtual numeric key pad to edit the value.  Click OK. 
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Data Graph Track Color 
You may edit the color of each track contained within the Graph List group.  To do this move the 

mouse cursor onto the color box of the track you want to edit.  Click the mouse to display the 

Color window.  See Figure 29. 

 

Figure 29 

You assign a track color by clicking a color box in the Basic colors table followed by clicking the 

OK button.  Alternatively, you may assign a custom track color by clicking a box in the Custom 

colors table, then clicking the Define Custom Colors >> button.  Click the OK button when 

finished. 

 

Data Graph Results 

With the tracks enabled and their colors assigned you are now ready to run an experiment and 

see the data graph results.  See Figure 30. 
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Figure 30 

In this example the y-axis is set to Semi-Log Scale.  The Experiment graphed here consists of a 

series of 25 runs.  Each run is shown as a small hollow circle in the graph window.  The circles 

for a given track are connected by straight-line segments.  This makes it easy for the user to tell 

what happened with each track of an experiment.  Notice that the Graph List pane shows a 

color-coded list of five tracks.  In this example the track values for each Run Number are 

graphed with the same color used for the track names shown in the Graph List.  You can toggle 

the Y-Axis in the graph over to linear mode.  You do this by clicking the Linear button located at 

the top of the Data Graph window.  This causes the Data Graph window to change to show a 

graph somewhat like Figure 31. 
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Figure 31 

With the Data Graph window set to Linear mode only the Number of Counts track is visible.  

Note that the y-axis has switched to linear mode, thus allowing much smaller range of graphed 

values within the same data graph.  This difference is one reason why you should consider 

using Semi-Log as the default Data Graph setting when graphing your experiment results. 

 

Common Commands 

To access the Common Commands window click the Common Commands icon  located 

in the Main Window toolbar.  Clicking this button causes the Command Commands window to 

appear.  See Figure 32. 
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Figure 32 

This window provides a list of commonly used commands.  It works similarly to how the Quick 

Commands toolbar works.  There are two differences between these windows.  Firstly, whereas 

the Quick Commands toolbar remains docked within the ST365 application main window, the 

Common Commands window floats.  Secondly, the Common Commands window contains 

several more commands than does the Quick Commands toolbar.  The Common Commands 

window contains an alphabetized list of menu command buttons. These buttons are named: 

 CLEAR EXPERIMENT RESULTS 

 DISCONNECT FROM DEVICE 

 HALF LIFE EXPERIMENT 

 LOAD FROM DATA GRAPH FILE… 

 LOAD FROM RUN RESULTS FILE… 

 PLATEAU EXPERIMENT 

 PRESET SETUP 

 PRINT DATA GRAPH… 

 SAVE ALL EDIT PARAMETERS 

 SAVE APP CONFIG SETTINGS 

 SAVE DATA GRAPH… 

 SAVE DEVICE PARAMETERS 

 SAVE RUN RESULTS TABLE AS… 

 SHUTDOWN 

 VIEW CONFIG SETTINGS 

 VIEW DATA GRAPH 

 VIEW DATA IO 

 VIEW EXPERIMENT RESULTS 
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Description of Common Commands 
Click the Clear Experiment Results button of erase the contents of the Experiment Results 

window.  The user may display the Experiment Results windows by clicking the Common 

Command button labeled View Experiment Results, discussed below. 

Click the Disconnect From Device button to close the connection to a currently-connected 

Spectrum Techniques device.  You will be asked whether you really want to disconnect from the 

device. 

Click the Half Life Experiment button to display the STU Half Life Experiment window.  This 

window allows you to configure and run a half-life experiment. 

Click the Load From Data Graph File… button to load the contents of a previously saved 

comparison graph file into the Data Graph window.  This is most useful in the case where you 

want to perform a visual comparison between different runs of a given experiment. 

Click the Load From Run Results File… button to load the contents of a previously saved run 

results table into the Run Results Table.  This is useful for displaying within the ST365 

application the results of a previous experiment run. 

Click the Plateau Experiment button to display the STU Plateau Experiment window.  This 

window allows you to configure and run a plateau experiment. 

Click the Preset Setup button to display the STU Preset Setup window.  This window allows you 

to configure the most important settings used when performing an experiment. 

Click the Print Data Graph… button to send the contents of the Data Graph window to a printer.  

This is useful in the case where you want to make a printout of the results of an experiment.  

Any notes that you create and that appear within the DataGraph window will also get printed. 

Click the Save All Edit Parameters button to save the current Edit Parameters settings to a file 

on your computer.  This is useful in the case where you want to keep a record of the current Edit 

Parameters settings for the purpose of restoring the settings later on.  Also, if the ST365 

application appears to be behaving erratically and you contact Spectrum Techniques Technical 

Support for assistance, the technician might ask you to create and send to them a copy of this 

settings file so they can examine it for any unusual values.  By default, each settings file gets 

saved to the C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\SavedEditParameters_Files folder. 

Click the Save App Config Settings button to save the ST365 application’s configuration to a 

config file on your computer.  Normally, there is no need to explicitly perform this action since 

the ST365 application automatically saves its config file when the user shuts down the 

application.  The file gets saved to the C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\AppConfig_Files folder. 

Click the Save Data Graph… button to save the current contents of a data graph window to a 

comparison graph file on your computer.  Later on, you can load this file back into the Data 

Graph window in order to perform a visual comparison between different runs of a given 

experiment.  Each comparison file gets saved to the C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\DataGraph_Files folder. 
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Click the Save Device Parameters button to save the current Spectrum Techniques device 

parameters to a parameters file on your computer.  Normally, there is no need to explicitly 

perform this action since the ST365 application automatically saves the device parameters to 

disk whenever the user disconnects from the device.  Each device has its own parameters file.  

All device parameters files are saved at the C:\ProgramData\Spectrum Techniques 

LLC\SpectrumTechniquesUltraST365\DeviceParams_Files folder. 

Click the Save Run Results Table As… button to save the current contents of the Run Results 

Table to a file on your computer.  Later on, you can load this file back into the Run Results 

Table.  This is useful for displaying within the ST365 application the results of a previously 

saved experiment run.  Each run results table gets saved to the C:\ProgramData\Spectrum 

Techniques LLC\SpectrumTechniquesUltraST365\RunResult_Files folder. 

Click the Shutdown button to close the ST365 application.  You will be asked whether you really 

want to close the application. 

Click the View Config Settings button to display a window that shows the current configuration 

settings for the connected Spectrum Techniques device.  All settings associated with the device 

are contained in the display window. 

Click the View Data Graph button to display the Data Graph window.  Note that if the Data 

Graph window is already displayed and is minimized, clicking this button has no effect.  It does 

not restore the Data Graph window back to its normal position on-screen. 

Click the View Data IO button to display the Data IO window.  This window presents a real-time 

display of all IO commands and responses transmitted between the ST365 application and a 

connected Spectrum Techniques device.  This is useful in the case where you want to see 

exactly what data is being sent and received while the ST365 application is controlling a 

Spectrum Techniques device.  The Data IO window has buttons that allow you to filter out the 

display of 03 commands (recommended as they get transmitted a lot and are not generally of 

any diagnostic use), Pause/Resume the real-time display of IO transmissions, Copy the 

contents of the Data IO window to the OS clipboard, Clear the contents of the Data IO window, 

and Close the Data IO window.  There is also a Send button that allows the user to manually 

transmit a command from the ST365 application to a connected Spectrum Techniques device.  

This is handy in the case where the user wants to send a query to a connected Spectrum 

Techniques device in order to have the device respond to that query. 

Click the View Experiment Results button to display the Experiment Results window.  See below 

for a detailed discussion of how this window works. 

 

Experiment Results 
The Experiment Results window displays summarized results from the most recent experiments 

performed using the ST365 application.  Prior to running any experiments the Experiment 

Results window will be blank as shown in Figure 33. 
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Figure 33 

Up to fifteen of the most recently executed experiment results will show in the Experiment 

Results window.  Results from the most recently performed experiments are displayed in rows 

with the most recent results shown at the bottom and older results shown in rows higher up.  

After the first fifteen experiments have completed and the user runs another experiment, the 

oldest one will disappear from the top row.  All remaining results will move up one row and the 

newest experiment result will appear in the bottom row.  The Experiment Results window’s main 

purpose is to allow the user to see at a glance a summary of the most recent experiments 

performed on the given station during the active session of the ST365 application. See Figure 

34. 
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Figure 34 

This sample Experiment Results window shows eleven rows of experiment results.  The rows 

are sorted from top to bottom in ascending chronological order and are alternately color-coded 

to make it easier to tell them apart.  This window is especially useful when the user wants to 

know what the ST365 application has been doing recently.  The first part of each row shows the 

date and time that a given experiment was run.  The next part shows the experiment type.  

There are three different experiment types: Raw Counts, Half-Life Experiment, and Plateau 

Experiment.  When Raw Counts is shown in a row, this indicates that the user clicked the green 

Start Counts button to start the experiment.  Rn shows the number of runs collected during the 

experiment.  Time shows the preset time and pause time that was used.  HV shows the voltage 

used in the case where the voltage remains constant over the course of the experiment.  For a 

Plateau Experiment LoV shows the low voltage used at the start of the experiment.  HiV shows 

the high voltage used at the end of the experiment.  CR shows the minimum and maximum run 

counts collected during a given experiment. 
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Edit Parameters 

To access the Edit Parameters window click the Edit Parameter icon  located in the Main 

Window toolbar.  Clicking this button causes the Edit Parameter window to appear.  See Figure 

35. 

 

Figure 35 

The Edit Parameters window displays parameter settings that control how the ST365 software 

application looks and behaves.  The parameters shown in the Edit Parameters window are 

divided into three groups: 

 Config Setup: contains system-wide parameters 

 Config OnOff: contains parameters that determine how the Spectrum Techniques 

device behaves when running an experiment 

 Config Delay: contains time-dependent UI parameters 

To open a particular group within the Edit Parameters window simply click the group’s name.  

This causes the plus (+) sign located immediately to the left of the group name to change to a 

minus (-) sign.  The group opens up to display its contents.  The selected parameter is 

highlighted in BLUE.  See Figure 36. 



47                                                                   Spectrum Techniques Ultra Rev. 1 

 

Figure 36 

In the figure shown above the Edit Parameters window shows that the currently selected 

parameter is a text-type and is named Host Computer.  The bottom-right corner shows that the 

currently assigned text is Spectrum Techniques Ultra.  A scrollable description of the 

parameter is displayed below the textbox.  The description offers a short explanation of the 

purpose of the given parameter.  Click the Save and Close button to update the selected 

parameter and to dismiss the Edit Parameters window. 

In addition to text-based parameters the Edit Parameters window contains numeric parameters.  

See Figure 37. 
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Figure 37 

In the figure shown above the Edit Parameters window shows that the currently selected 

parameter is a numeric and is named Max Allowed Number Of Runs.  The bottom shows that 

the currently assigned numeric value is 5000.  The scrollbar located to the right of this numeric 

value allows the user to easily adjust the value anywhere between its minimum and maximum 

allowed limits.  A description of the parameter is displayed below the numeric value.  The 

description offers a short explanation of the purpose of the given parameter. 

A third type of parameter used in the Edit Parameters window is the enumeration parameter.  

See Figure 38. 
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Figure 38 

In the figure shown above the Edit Parameters window shows that the currently selected 

parameter is an enumeration and is named Spec Tech Device.  The bottom shows that the 

currently assigned enumeration value is ST365LCD.  A description of the parameter is 

displayed below the enumerated value.  The description offers a short explanation of the 

purpose of the given parameter. 

A fourth type of parameter used in the Edit Parameters window is the On/Off parameter.  See 

Figure 39. 
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Figure 39 

In the figure shown above the Edit Parameters window shows that the currently selected 

parameter is an On/Off type and is named Runs Remaining.  The bottom shows that the 

currently assigned value is ON.  A description of the parameter is displayed below the value.  

The description offers a short explanation of the purpose of the given parameter. 

List of Edit Parameters 
Parameter ID Default Value Description 
   

Setup Settings 

Host Computer Spectrum 
Techniques Ultra 

Name used by the STU application to identify the particular computer 
on which the application is running.  Useful in the case where there 
are multiple computers located in the same physical area all running 
the same STU application.  Using a different System ID for each 
computer assists technical personnel who need to know which 
computer needs technical assistance. 

Max Allowed 
Number Of Runs 

5000 Warning: Setting this value above 5000 might result in unstable 
computer behavior during an experiment due to excessive RAM 
memory usage required.  This parameter defines the maximum 
allowed number of runs that the user may specify when setting up the 
experiment parameters. 

Max Allowed 
Debug File Size 

1000 Maximum allowed file size (in MB) for storing debug information. 
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OnOff Settings 

Spec Tech Device ST365LCD Select the device type to use with this application. 

Runs Remaining ON Turn this parameter ON to have the Run Results Form include a 
column for RunsRemaining. 

Number of Counts ON Turn this parameter ON to have the Run Results Form include a 
column for NumberofCounts. 

Date and Time ON Turn this parameter ON to have the Run Results Form include a 
column for Date and Time. 

Pause Time ON Turn this parameter ON to have the Run Results Form include a 
column for PauseTime. 

Preset Time ON Turn this parameter ON to have the Run Results Form include a 
column for PresetTime. 

Elapsed Time ON Turn this parameter ON to have the Run Results Form include a 
column for ElapsedTime. 

High Voltage ON Turn this parameter ON to have the Run Results Form include a 
column for HighVoltage. 

Lower Threshold ON Turn this parameter ON to have the Run Results Form include a 
column for LowerThreshold. 

Auto Show Data 
Graph 

ON Turn this parameter ON to automatically display Data Graph when 
experiment starts. 

Trim Nulls From 
Front Of Serial 
Data 

OFF Turn this parameter ON to trim all occurrences of null characters found 
at front of serial data packets received from ST365. 

Require User to 
enter Telnet Port 

OFF Turn this parameter ON to require the user to enter a telnet port 
number each time they connect to Spectrum Techniques device. 

Telnet Port Port23 Select the telnet port number used for IP communication with 
Spectrum Techniques device. 

Simulated Counts 
Data 

OFF Turn this parameter ON to use simulated counts data from clock inside 
Spectrum Techniques device (instead of using counts from attached 
probe) when experiment starts. 

Write Debug Info 
To Log File 

OFF Warning: Turning this parameter ON might result in unstable device 
operation.  Turn this parameter on to cause STU application to record 
debug information to a log file.  This file resides at 
C:\ProgramData\Spectrum Techniques 
LLC\SpectrumTechniquesUltraST365\Log_Files. 

 

Delay Settings 

MessageBox 
Timeout 

5 (Seconds) Amount of time to leave a message box up on the screen 
before automatically closing it. 

 

 

SYSTEM OPERATION 
Basic GM Tube Setup and Operation 
Warning! 
Dangerous voltages can exist at the GM and SCINT connectors.  Ensure that the high voltage is 
set to zero or that the device is turned OFF before connecting or disconnecting a detector. 
 
Caution: 
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Simultaneously connecting a GM tube and a scintillation detector to the Spectrum 
Techniques hardware device will result in erroneous data.  Only connect one or the other, 
not both. 

1. Connect the Spectrum Techniques hardware device to its AC adapter. 
2. Connect a GM tube to the GM connector via a BNC cable. 
3. Enter the HIGH VOLTAGE mode and set the high voltage to the recommended value for 

the GM tube. 
4. Place the radioactive source close to the GM tube’s window. 
5. Using the Operating Mode information described above, set the unit up to perform the 

desired function. 
6. Click the START COUNTS button to begin data acquisition.  Click the STOP COUNTS 

button to halt data acquisition.  Click the CLEAR CONFIGURATION PARAMETERS 
button to reset the time and data to zero. 

 

GM Tubes 
Geiger-Mueller tubes produce electrical pulses when ionizing radiation events occur within their 
sensitive volume.  For proper operation, run these detectors only at the manufacturer's specified 
voltage.  If this voltage is not known, then it must be derived empirically by graphing a plateau 
(see below).  To improve sensitivity to alpha and beta particle radiation, many GM tubes have 
extremely thin entrance windows, which require considerable care in handling.  Do not remove 
protective caps unless necessary and never touch the window. 
 

GM Tube Plateau 
The correct operating voltage for the Geiger-Mueller tube may be determined experimentally 
using a radioactive source such as Cs-137 or Co-60.  A properly functioning tube will exhibit a 
"plateau" effect, where the counting rate remains nearly constant while the high voltage is 
increase from one run to the next.  A plateau chart is obtained by using a constant preset time 
to count a source over several runs, while increasing the high voltage by some constant amount 
after each run.  This process is described in detail in the next section, Creating a Plateau Chart. 
 

Creating a Plateau Chart 
Running the unit as a stand-alone unit 

1. Place the radioactive source in a fixed position close to the window or in the well of the 
detector. 

2. Put the Spectrum Techniques device into Count mode and slowly increase the high 
voltage until the device begins to register count activity.  Stop counts. 

3. Set the Preset Time to 10 seconds and start counts. 
4. When the preset time expires, record the counts and the high voltage setting. 
5. Increase the voltage by 20 volts and collect count data again. 
6. When the preset time expires, record the counts and the high voltage setting again. 
7. Repeat steps 5 and 6 until the high voltage reaches its upper limit (this is determined by 

the upper operating voltage limit of the detector). 
8. Create an X-Y graph of the data, with “Y” being the Counts, and “X” being the voltage, 

and graph the chart. 
 

Using the ST365 application software 
1. Place the radioactive source in a fixed position close to the window or in the well of the 

detector. 
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2. Put the unit into COUNT mode and click the Start Counts button.  Slowly increase the 
high voltage until counts start to appear in the Information Window.  This is the starting 
voltage. 

3. Determine the upper operating voltage limit of the detector.  This is the ending voltage. 
4. Subtract the starting voltage from the ending voltage.  Divide the result by the high 

voltage step size (20 volts in this case).  This tells you the number of runs. 
5. Select High Voltage Setting in the Setup menu and set the High Voltage to the starting 

voltage and the Step Voltage to 20.  Also, turn the Step Voltage Enable ON. 
6. Select Preset Time in the Preset menu and set it to 10 seconds. 
7. Select Runs in the Preset menu and set it to the number calculated in step 3. 
8. After counting has begun, it will automatically stop when runs equals zero. 
9. Save the data to a file.  Before saving, a description of the data may be entered into the 
1. Description box. 
10. Open the saved file version with a .TSV (tab separated values) extension into a 

spreadsheet program such as Microsoft Excel. 
See Figure 40 for an illustration of a typical detector plateau. 
 
 
 
 

 
Figure 40 
 
Notice that the counts form a relatively flat place on the graph between 850 and 1100 volts.  The 
center of this area, at approximately 1000 volts, is the recommended operating voltage for the 
detector.  However, any voltage in this flat region would be acceptable.  Also, notice that the 
counts increase rapidly as the high voltage nears its upper limit.  This indicates that the tube is 
entering its breakdown region.  Do not continue to operate the tube in this region. 
 

Resolving Time 
Geiger-Mueller tubes exhibit dead time effects due to the recombination time of internal gas ions 
after an ionizing event occurs.  The actual dead time depends on several factors including the 
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active volume and shape of the detector.  Dead time can range from a few microseconds for 
miniature tubes, to over 1000 microseconds for large volume devices. 
 
When making absolute measurements it is important to compensate for dead time losses at 
higher counting rates.  If the resolving time of the detector is known, the true counting rate may 
be calculated from the measured rate using the following expression: 
n= m / (1 - mt) 
 
where n is the true counting rate, m the measured rate, and t the detector resolving time. 
 
If the detector resolving time is unknown, it may be determined experimentally using two 
radioactive sources.  Maintaining constant counting geometry is important throughout the 
experiment.  A special source split into two halves (Spectrum Techniques part # RSS-2) is 
available for making the measurement, but good results may be obtained by careful positioning 
of two standard check sources.  Perform the following steps to calculate the resolving time: 

1. Set the Spectrum Techniques device to Rate mode. 
2. Position the two sources (a+b) side by side and close enough to the GM tube’s window 

to obtain a count rate of at least 10,000 CPM. 
3. Record the count rate as R(a+b). 
4. Remove source (b) and record the count rate as R(a). 
5. Carefully replace source (b) to its original position, remove source (a) and record the 

count rate of source (b) as R(b). 
Solve for the resolving time using this equation  
 
T = (R(a)+R(b)-R(a+b)) / (2R(a) *R(b)) 
 
The resolving time of the Spectrum Techniques RADIATION COUNTER is very short and is not 
a significant factor compared to that of the GM tube. 
 

The Wipe Test System 
The Spectrum Techniques Radiation Counter will also operate with scintillation tubes for 
detecting low-level gamma and X-ray emission from a variety of samples.  The Wipe-Test 
system includes a well detector, base, cable, and lead shield for measuring wipes or tube 
samples. 
 
This system will detect gamma and X-rays ranging in energy from 20 keV to several meV.  Each 
system is factory calibrated and should not require further adjustment unless a different detector 
or base is used.  A Cs-137 calibration source is included for routine checking of overall system 
performance and quality assurance.  Details of the Wipe Test system setup, operation, and 
calibration are covered in the following sections. 
 

The Wipe Test 
The Wipe Test system should be set up in the following manner: 

1. Install the scintillation detector into socket in the base of the stand.  Note that the base of 
the detector is keyed and will only locate in one position of the socket. 

2. Place the lead shield over the top of the detector allowing it to rest on the vertical metal 
support tube. 

3. Insert the plastic liner into the well. 
 
Caution: 
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This liner provides protection from mechanical damage and contamination.  The 
aluminum wall inside the well is very thin and can be damaged if a tube is inadvertently 
dropped into the well without the liner in place. 

1. Connect the coaxial cable from the detector assembly to the input labeled SCINT on the 
rear of the Spectrum Techniques device. 

2. Turn the Spectrum Techniques device ON.  Using either the ST365 software application 
or the front panel controls set the high voltage to the value marked on the detector 
assembly. 

3. Set the Preset Time to the desired number of seconds and begin counting. 
 

Checking the System Calibration 
Use the supplied calibrated Cs-137 source to check the counting efficiency and overall system 
performance.  This source has its activity marked in counts per minute (cpm) and the date of 
manufacture. 
Over time, the source decays with a half-life of 30.1 years and it will be necessary to periodically 
correct the activity. 

1. Place the calibrated Cs-137 source into the plastic well-liner and into the well of the 
detector. 

2. Set the Preset Time to 60 seconds and begin counting. 
3. After counting is finished, the reading should correspond within ±10% of the activity in 

counts per minute recorded on the source.  For better accuracy, use the average of 
three separate readings. 

 

Taking a Background Reading 
Wipe tests are inherently low-level measurements and it is necessary to perform background 
subtraction on all samples to generate accurate activity data.  Because the background reading 
is low, it should be counted for a longer period to improve the statistics. 

1. Remove all radioactive material from the vicinity of the detector. 
2. Set a preset time of 600 seconds and begin counting. 
3. When counting is complete, record the value and divide it by 10 to derive the 

background counts per minute. 
 

Measuring Wipes 
1. Using the well-liner, position the sample into the well of the detector. 
2. Set the preset time to 60 seconds and begin counting. 
3. When counting is complete, record the number of counts. 
4. Subtract the background counts-per-minute and record the value.  This is the correct 

counts per minute for the sample. 
 

System Re-calibration 
The system is calibrated at the factory, and under normal circumstances, recalibration should 
not be required.  However, in the event of a detector or detector base replacement, it will be 
necessary to determine the correct operating voltage for the system.  Using the Cs-137 source 
supplied with the system, refer to the section Creating a Plateau Chart to obtain the correct 
operating voltage.  See Figure 41 for an illustration of a typical detector plateau showing the 
optimum operating voltage. 
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Figure 41 
 
 

Warranty and Repair Information 
Spectrum Techniques warrants products of our manufacture against defects in workmanship or 
material for a period of one year from date of shipment.  We will repair or replace, at our option, 
any device that is deemed defective during this time.  This warranty covers all replacement 
parts and labor.  The device must be returned to our factory prepaid and we in turn will pay the 
cost of the return shipping. 
 
The warranty does not cover damage caused by mishandling or misuse.  GM tubes with broken 
windows are specifically excluded from this warranty.  Accessory items not manufactured by 
Spectrum Techniques but supplied as part of our systems will be subject to the original 
manufacturer’s warranty. 
 
For warranty-repair information or return authorization, contact customer service at: 

Spectrum Techniques 
106 Union Valley Road 
Oak Ridge, TN 37830 
Tel: (865) 482-9937 
Fax: (865) 483-0473 

spectrumtechniques.com 

http://spectrumtechniques.com/

